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Welcome From The Chief Editor
Every Linux user must have heard about the recent "news" of vulnerabilities in Linux. Particularly, I'm talking about the "Heartbleed" issue surrounding the implementation of the OpenSSL libraries. To understand the "vulnerability," you first have to understand what the OpenSSL libraries actually do. Here's a brief description from Wikipedia:
OpenSSL is an open-source implementation of the SSL and TLS protocols. The core library, written in the C programming language, implements the basic cryptographic functions and provides various utility functions. Wrappers allowing the use of the OpenSSL library in a variety of computer languages are available.
In a nutshell, OpenSSL helps to keep our communications and transactions over the web safe, on information resources that utilize SSL and TLS security. It helps to keep your identity and passwords secure, between you and the server. Furthermore, it helps to keep your credit card information -- as well as any other sensitive private data -- secure from those who may want to intercept it.
As it turns out, OpenSSL had a "chink" in the armor. A simple programming mistake by one of its maintainers allowed snoops to not only intercept usernames and passwords, but also any sensitive, private data that was shared -- and even the server's SSL and TLS keys!

If you're somewhat confused on what Heartbleed is all about, here's an excellent summary from Wikipedia, from that same article:
OpenSSL versions 1.0.1 through 1.0.1f had a severe memory handling bug in their implementation of the TLS Heartbeat Extension that could be used to reveal up to 64 kilobytes of the application's memory with every heartbeat. By reading the memory of the web server, attackers could access sensitive data, including the server's private key. This could allow attackers to decode earlier eavesdropped communications if the encryption protocol used does not ensure Perfect Forward Secrecy. Knowledge of the private key could also allow an attacker to mount a man-in-the-middle attack against any future communications. The vulnerability might also reveal unencrypted parts of other users' sensitive requests and responses, including session cookies and passwords, which might allow attackers to hijack the identity of another user of the service. At its disclosure, some 17%, or half a million, of the Internet's secure web servers certified by trusted authorities were believed to have been vulnerable to the attack.
More information about the Heartbleed exploit can be found here, here, here, here, and here.
In response, the Linux community, along with other members of the open source community, rallied around OpenSSL. A fix was made in a very short time, and that fix made its way out to users almost immediately. In response, The Linux Foundation started the Core Infrastructure Initiative, aimed at improving global security, enabling outside reviews, and improving responsiveness to patch requests. The founding members of the Core Infrastructure Initiative reads like a "who's who" among tech giants. They are The Linux Foundation, Google, Dell, Amazon Web Services, Cisco, Facebook, Fujitsu, IBM, Intel, Microsoft, NetApp, RackSpace, and VMware. And, the initial focus for the CII group is the OpenSSL Foundation.
Each company has agreed to contribute $100,000 per year, for a minimum of three years, to help fund the work on OpenSSL. Over that three year period, that will amount to $3.6 million. This should go a long way in improving security. The programmer who accidentally introduced the bug into the OpenSSL source code stated that the project is "definitely under-resourced for its wide distribution. It has millions of users, but only very few actually contribute to the project."

Some might argue that it's foolish to just throw money at an open source project. But, without funding, many open source projects wither and die on the vine. Without funding, the necessary resources cannot be allocated to not only the continuation of the project, but almost insuring that the project is unable to meet its goals. With a library such as OpenSSL, there are many using the libraries who profit from the work, and it has become a global de facto standard for helping to provide secure communications and transactions across an ever growing web.
What's so exciting about being a Linux user and an open source software user -- and a PCLinuxOS user, in particular -- is that the vulnerability was patched and upgrades posted to the repos of most Linux distros before the ink had dried on the headlines. There was no waiting a month or more for a "Patch Tuesday" to address the issue. Nope. Quickly and quietly, without many users even realizing it, the vulnerability was addressed and closed.
No operating system can be 100% bullet proof. That includes Linux. But you have to admit that Linux is far less vulnerable than any commercially available operating system. Thanks to its open source architecture,
The "takeaway" from all of this is at least two fold. First, it's important that open source projects receive the necessary funding to continue to meet their goals, especially when the use of that open source project has reached widespread use. Second, it illustrates perfectly the speed at which the open source community can respond to threats, given the fact that the source code is open and free to view, by anyone who wants to view it, and they may freely contribute to such projects. With "many eyes" able to view the source code, as opposed to only a few eyes of a privileged few, bugs and vulnerabilities can be more addressed more quickly, and the community at large can prevent the exploitation of other users by those with ulterior and cynical motives.
Rest assured, both the main PCLinuxOS website and The PCLinuxOS Magazine website are safe and free of the Heartbleed vulnerability. So, until next month, I bid you peace, happiness, serenity and prosperity.
Is Linux FINALLY Getting Its Due Attention?
by Paul Arnote (parnote)
It's no secret that Windows XP reached its end of life on April 8, as Microsoft withdrew support for its aging (yet still popular) operating system. That means after April 8, 2014, there will be no more security patches or updates for Windows XP. Of course, this could increase the vulnerability of remaining XP users to viruses and other forms of vicious malware. With Microsoft no longer offering support, hackers and virus writers should have a field day exploiting any remaining security holes in the OS ... and it has as many security holes as a block of Swiss cheese.

Wallpaper downloadable from here.
The sun had barely set on XP when ... FINALLY ... Linux received some very favorable press in the mainstream media the very next day. Say what? Yep. In the mainstream media. And not just any mainstream media outlet. The New York Times! It's really not unusual to see Linux grab some headlines in the computer and IT press. But it really is very rare to see any mention of Linux in the mainstream media. The only thing missing from the article was mention of our favorite Linux distro.
And why shouldn't Linux finally receive some favorable press? After all, people use it every single day, without even realizing it. It forms the basis for their Android phones and tablets. It provides the interface for their set top DVD players. It supplies the basis for the option menus of their television sets. It powers their ebook readers. Of course, for us around here, it serves as the foundation for our computers.
With an estimated 24 million Windows XP users, coupled with the end of support for Windows XP, there is a HUGE opportunity for Linux to not only increase its numbers, but to remain in the headlines. Linux offers perfect asylum to Windows XP users, freeing them from the endless attacks on their now-more-vulnerable-than-ever operating system. Plus, there are a lot of choices for XP users to install Linux on their aging computers, especially since Linux runs well on older hardware.
Already, I've started seeing Windows XP refugees in the PCLinuxOS forum. They are seeking out a long term solution to the lack of support for their favored operating system. Indeed, a lot of Windows XP users remain somewhat confused by the end of XP support, despite all the hoopla surrounding its demise. Even my best friend, one of those 24 million Windows XP holdouts, asked me if it was ok for him to turn on his laptop. I assured him that he was protected and fine -- for the moment -- and to go ahead and do what he needed to do. I reminded him that we'd be installing a version of PCLinuxOS on his computer very soon. He is very agreeable to having PCLinuxOS on his computer, and has put his full faith and trust in me to help provide him with a safe computing environment.
As such, we need to be ever vigilant to help these Windows XP refugees -- now new Linux users -- to find their way around. Yes, it may mean answering those same questions we have all answered 1,000 times before, several more times. For as quick as we are to tell new users that Linux is not Windows, it's just as important for us to remember that very same thing as we help these new users along. We were all "new Linux users" at one time, ourselves. Forget about "paying dues." If we can make their transition to Linux that much easier, we'll have gained loyal users who were just as loyal to their beloved Windows XP.
The opportunity for Linux growth is as ripe now as it ever has been. The "death" of Windows XP, coupled with the lackluster reception of Windows 8, now should be the perfect opportunity for Linux to catapult into the mainstream computing world. Apple has priced the Mac OS-X systems out of reach of most users. Plus, XP users see no reason to replace their hardware that has -- and continues to -- serve them well. Linux is as good of a fit as a hand in a custom made glove.
If you are one of those Windows XP refugees ... welcome to PCLinuxOS! Please check out the Windows Migration Guide Special Edition of The PCLinuxOS Magazine. We think it will help you make the transition to PCLinuxOS.
Maybe ... just maybe ... 2014 will be the year of the Linux desktop.

Have You Left a Trail Today?
by Paul Arnote (parnote)
Personally, I know there's hardly a day that goes by that I don't use an internet search engine -- usually Google -- to look up something. I'm betting you do the same. In fact, I'm betting that most people do the same.
But, in your searching, did you leave a trail? Chances are good that you did, and you didn't even realize it. You almost certainly did if you logged into your "account" on a particular search engine. That is, unless you took precautions beforehand.
Yahoo, Bing, Google and a whole host of other, smaller search engines collect your search data to help target the ads that they deliver to you. Your data is valuable. Not only to you, but also to those who are using it to target the ads delivered to you to include things you are interested in. After all, you are much more likely to buy something that's related to your interests than an item that's randomly served up.
In fact, your search data contains some of the most private data about you. From it, they can ascertain your mood, your likes, your fears, your shopping habits, your travel plans, and a whole host of other information that you aren't that keen on sharing openly. What's unknown is how much of your search data is retained, and for how long. This is what makes this all so scary.
Google makes it relatively easy -- the easiest of all the search engines -- to opt out of the collection of this data. Simply go to http://www.google.com/history. There, you can delete any or all of your search data history. You can also opt out of it, altogether, if you wish. Even though I have been "opted out" of Google's collection of my search data for a very long time, many users don't realize that this option exists. Below is what the Google page looks like. If you don't have your search history turned off (as I do), your options will be different.

Keep in mind that this doesn't eliminate ads from appearing. They will just be "less relevant" ... presuming they were relevant in the first place. Personally, I'd prefer no ads at all. In all of the years that I've used Google, I've never purchased anything based on an ad that was served up to me. Even when I had the history turned on (before I found out about this), the ads had little to no relevance to anything that I was interested in.
Speaking of ads, you can also exert some control over the ads that Google serves up by going to http://google.com/settings/ads and adjusting your ads settings. You can also install a browser extension that opts you out of the DoubleClick cookie that Google uses.
Bing is reported to have something similar, but nothing is evident on the Bing site without logging in. I won't be logging in, since I don't want or need an account on a search engine that I refuse to use (on account of it being a Microsoft site). Others have reported, though, that you can go to https://www.bing.com/profile/history to turn off and erase your search history.
It has been reported that going to http://search.yahoo.com/preferences/ will allow you to turn off Yahoo!'s search history, but there is no way to erase your search history. Using one of my older, seldom used Yahoo! accounts, I was unable to find any way to turn off Yahoo!'s search history.
Even without tracking your search history, search engines can -- and do -- make money off of serving up ads to you. Instead of basing them off of your search history, they can simply base the ads off of your current search words and phrases that you enter. DuckDuckGo does this, and they still make money from serving up ads to their search engine visitors. DuckDuckGo does not save your IP address, use cookies, or keep a database of search terms that can be directly linked back to you. IXQuick.com and StartPage operate in a similar way. So no, it's not necessary for Google, Bing and Yahoo! to save your personal search data in order to make money by serving up ads to you.
Summary
When you consider that Google "hosts" over 100 billion searches a month, we're talking about a wealth of user information being collected -- and stored for who knows how long -- that users typically don't realize that they are giving up. And that's only Google that we've used as an example. With the NSA, GCHQ and other government agencies -- and even governments themselves -- prying into the lives of private individuals without a warrant or cause, privacy concerns are as high as they have ever been. Now, we have corporations saving data about us, and it's data that may reveal things we're not willing to openly admit or own up to.
The thing to keep in mind is that corporations exist to make money. Who knows how safe your data is. Everything has its price. We've seen companies, like Google has done on their founding principle of "do no harm," do an about face. The big search engines can tell me all they want that my data is safe, but I don't believe them. How long will it be before my search data is sold to the highest bidder?
So ... have you left a trail today?
KDenLive Mid Term Review
by loudog
Hello friends, spring has finally sprung here, and although I'm not sure about where you live, chores are suddenly appearing as if out of snow-where. I am personally befuddled how I found the time, let alone the energy, to write this for the PCLinuxOS fans that read the monthly mag, but it simply appeared, like spring's tender shoots, from out of nowhere.
Speaking of shoots, we have a special video for you this time, one that was specifically asked for me to create, in .... get this, "make it in that Linux thing you have on our computers." My wife's best friend, bless her soul, (in the pink blouse in the video) who has been using PCLinuxOS on my advice for about 5 years now, requested a video that could be featured in the mag with her and friend's permission. After such a long and stagnating winter, I feel it is time for a review of what we have learned so far and ask that you take some time to reflect on the important points I make. This will prepare you for some exceedingly intricate and detailed video editing tutorials in the future.
In Part One, we discovered the basic functions of the GUI, how to import clips, add clips to the project timeline, download audio/video files from the open source library, create an intro and exit strategy, and stitch some videos together in a basic manner. The biggest reminder I would like to convey from Part One is the open source audio/video library. This resource has many, many items to use in the editing process, and is invaluable at times. So please, do not forget about it.

In Part Two, we discovered how to extract images from a video, how to expand the project timeline right down to the individual frames, how to extract particular zones from a video clip, how to split the audio from the video track, how to add an audio track for background feeling, and how to adjust the volume of the background audio for balance. I want to emphasize from Part Two, the importance of splitting the audio/video tracks for enhanced editing purposes in "future articles."

In Part Three, we started learning about KDenLive's default applications, and how to change them. We also covered working with single images, utilizing the pan and zoom effect, the "distort" checkbox, how keyframes work, the "save your booty's hard work to this point" "save" button, the importance of reviewing the edited project many times before rendering, reviewing the rendered project before deleting the project, and the basic "how to cut clips in the project timeline" tool. I am implicit on the importance of the need to fully understand the what, why, who, where, when, and how keyframes are used and manipulated in the editing process. Keyframes are not the bread and butter, but the meat of video/audio editing. It is the "most important" thing we touched on in the third tutorial.

In Part Four, we learned how to prepare an image/video to have a transparent area so we may insert an image/video within the specified zone (in the background) with the blue screen effect. The information paramount in video editing that I want to draw your attention to from this article is the fact that: You will have greater feel/effect if you take the time to manipulate the video/image in the foreground and at the same time manipulate the image/video in the background. I quote from the Part Four article:
"As the camera zooms in on the window, the background image is also zooming in at a much slower rate giving the appearance or reality of walking to the window to look out. This may take a few tries to get right, just keep reviewing and editing it until you have something you like."
This is paramount for giving a polished "look" to your videos. In the foreground effect stack image (effects for door2.png), notice the timeline readouts in both images.

Background effect stack image (Effects for Supercell_Thunderstorm2.png).

The timeline readout will let you get your effect edits exactly aligned.
In Part Five, we explored some of the effects that you can implement with the "Affine" transition. We covered the background color/video/image choices that you have, the rotational axis controls and how to zoom in or out while also selecting the position of the image/video, and timing of the effects. At this time, without trying to sound redundant, I want to point out the importance of keyframes and the timeline-readouts between two different clips for getting things perfectly aligned for the best "look." The affine transition rotations can be very visually pleasing when combined with other effects in a "composite edit," if the timing is spot on.

This is a screenshot of our first video project timeline with the kindergarten effects that we learned.

Here is an image of the video project timeline of a video I made for a friend. You can't fit it all on one screenshot. She wanted herself and her friends to look like they were rough and ready ladies, but in reality they had very limited experience in shooting firearms. I "shot" many different videos that day of them practicing their shooting skills, and created something that has the look and feel of girlie rough/toughness. These girls were, in reality, not as hot a shots as what you see in the video but they certainly liked sharing it on the social network. My wife's best friend said "you made us look bad a$$ with that Linux video thingy." Got to love the trusting souls. They will use PCLinuxOS until you tell them no. By the way, never, ever believe what you see on the screen.

At this time, I would like to sincerely apologize for not spending this kind of time on the KDenLive tutorial videos, but so much other time is spent on creating/writing the article to begin with. And anyway, this is about teaching you to make the video's that your friends and families love, not tutorial videos. Let's see if you recognize the different effects that we have covered in previous articles, and the ones we haven't. To view the video, go here.
I really wonder who in the community can tell me what effects I used in this video that we haven't covered, many, many I am sure. Until next time, Spring forward to spring. I'm getting a tan already, and Tux is flustered, becauses he can't find his sunglasses!
ms_meme's Nook: Linux Days Are Here To Stay
Inkscape Tutorial: Create a Paisley Pattern, Part Two
by Meemaw
Last month, we started a paisley pattern using our decorative patterns created the month before. I did a different colored paisley as well.

Let's take the original on the left and add a bit more to it. Click on the innermost curve. You will find that all you can select is the objects along that curve, so since you have them selected, press your right or left arrow key five or six times (remember how many times you pressed). This will move the objects over enough that you can choose the curve itself. Choose the curve and duplicate it as we're going to make another. Click <CTRL> + ( nine or ten times to make the duplicate smaller. Now, click on your objects that you just moved and press the opposite arrow key to move them back into place.
Now choose the duplicate curve you just made. This one we're going to fill rather than putting a pattern on it. Choose a color that looks good with the rest of your project and fill your curve. If you want, you can choose another color and make it the stroke color. I used the purple and pink I've been using, and the pink stroke was size four.

Many times, a paisley design will have some sort of flower motif in the center. I am going to make a flower using the star tool. With the following settings:
12 corners, spoke ratio .25, rounded .45 - duplicating twice and setting fill and stroke different on each, plus a circle for the center,

I made this object. You will have to rotate two of the flowers so the petals will all show instead of being stacked right on top of each other.

I made this flower lighter because the object I'm going to place it on is darker. I then placed it in the object we made at the start of this article. My paisley now looks like this:

If you don't like that particular pattern, feel free to design one of your own, or search for something you like among the millions of free clipart objects on the web.
I like this, but I want to put in some accent strokes. Once again, using my Bezier tool, I drew a curve but this time it looks more long and pointed. Again choosing Path > Object to path, I used the node tool and auto-smooth to make it the way I wanted it. This one is only accent strokes, so it's going to be smaller. I duplicated it three times, then changed the fill and stroke for each.

These can be flipped and rotated whichever way you want them to be placed into your pattern. I'm finished with mine, but you can certainly do whatever you want to yours, adding smaller flowers or some other accent shape. Your choices are up to you. You might also group it all, selecting your whole pattern by drawing a rectangle around everything with your mouse, and clicking on the Group tool. You can also export it in an image format, such as .jpg or .png. Mine now looks like this:

Wow! We learned several tools this time! I'm sure your paisley pattern is wonderful! It might be fun to show everyone else what you've made. I'm going to put mine up as a wallpaper, and post it in the desktop screenshot section of the forum. I'd like to see yours as well. You don't have to leave it your wallpaper if you don't want to...just long enough to take a screenie. Here's mine, but I posted it, too.



PCLinuxOS Recipe Corner

Mouth Watering Fall Off The Bone BBQ Ribs
These ribs take a long time to slow cook, but the results are beyond finger licking good.
Things you will need:
Pork bareback ribs
Marinade of your choice.
BBQ sauce of your choice.
Dish (Glass cake pan will work)
Aluminum foil
Brush (also called a mop) to spread BBQ sauce
Gas or Charcoal Grill
Put the ribs in shallow dish, meaty side down (can be glass, ceramic, whatever you have that that will fit the ribs in). Add your marinade. Then cover, and put into the fridge overnight.
Pour out your marinade. You can leave a little of it in your dish to help add more flavor as you cook. However, I recommend that you don't leave all of your marinade in your dish.
Once you pour out your marinade re-cover with aluminum foil.
Preheat your oven to 250ºF
Place your covered ribs in the oven. Now cook at 250ºF for 3-4 hours. Set it and forget it. There is no need to do anything until you're ready to BBQ.
First prepare your grill. I prefer charcoal so that's what I am using.
The trick to charcoal grilling is to let your lighter fluid soak for a couple minutes. Also, remember to allow your charcoal to turn white to almost white before grilling. It allows for a more even burn.
After your charcoal has turned white to almost white it's time to start adding ribs and BBQ sauce.
First place your meat onto the grill (may already be falling off the bone so be careful).
Second add your favorite BBQ sauce spreading on in a nice even layer with a brush. Cover up your grill and allow to cook for 10-15 minutes.
Third Flip meat and repeat by adding more BBQ sauce and cooking for 10-15 minutes.
Now your ribs are done. Eat and Enjoy the mouth watering fall off the bone ribs you just made. It took awhile to make, but the satisfaction of eating them is well worth it. If you happen to have leftovers (which I doubt you will) you can make an amazing pulled pork sandwich. Enjoy!
Backing Up Your Files
by The PCLinuxOS Magazine Staff
If you have been running a computer system for a while, it will be tuned to your personal taste, and without doubt, you will have accumulated a large number of mostly insignificant files, together with a few crucial ones which you cannot afford to lose.
When your system breaks, for whatever reason, you need to be able to get it back up again ... fast. When your files disappear, you need to get them back. If you have backups, you are cushty. If not, perturbed.
Any number of things can break files and systems. Power spikes/brownouts, hardware breakages, bad updates, user abuse, stupidity, fire, weather events, a mad axeman. The problem will inevitably arise unexpectedly and usually at the worst possible moment to upset your tranquillity.
To ameliorate such a happenstance, you need backups of your files, and maybe your system. There are an abundance of gotchas you need to consider. For example, if you are doing a synchronised copy from a source to a destination, you need to be aware that if your source files are corrupted, then so the destination files will be, too. If the destination backup has an issue, then you have no backup. If your source and backup files are in the same box or building, then you have no backup if the box/building is destroyed. Off site and offline backups of particularly critical files are to be commended, but given special consideration.
Backing up your system.
For free software systems, we can download a system ISO and reinstall, followed by updating and tweaking to get a system back as it was. This can be a little time consuming.
You can alternatively backup your al dente system by making a "live" ISO with the nifty mylivecd utility from time to time. My own preference is to backup my system partition (sda1 on my computer) with a clonezilla "live" disk once a month, with two images available. This has saved me many times over, usually from my own meddling. There are tutorials for both of these on the forum and for Clonezilla in the June 2011 magazine back issue.
For a Clonezilla "live" session the procedure is:
Saving > Beginners Mode > Save Parts > This sda1 partition > Done
Recovery > Expert Mode > Recover Parts > This image > Don't touch MBR > Done
For me, saving and recovery are a five minute job. Your results may differ, based on the speed of your DVD writer, the medium being used to record the disk images, the size and speed of your hard drive, the amount of memory on your system, and the processor speed. Some users could see their efforts take two hours, or more. However, it's a well spent two hours or more, to protect your data.

Backing up files.
For backing up files, the rsync command is your friend. If you want a nice front end, Luckybackup is powerful and easy. There is a nice tutorial in the July 2011 magazine back issue.
The mechanics of the rsync command are easy (ensure you run as root if backing up for many users):
rsync --archive --delete /source /destination
--archive preserves all permissions
--delete synchronises source and backup files (watch out for corrupted source files)
Note /source means copy over the directory and subdirectories of /source. Whereas /source/ (see the trailing slash) means copy the contents of / source. Be careful.

To make this happen without you worrying about it, create a script with something like kwrite and make the file executable. Then as root in Configure Your Desktop > Task Scheduler, create a recurring cron job to run your script when you want it to run. Ensure this cron job is a Personal Cron for root rather than a System Cron: otherwise it will not work.
Example simple script to copy to a second attached backup drive:
mount -t ext4 /dev/sdb1 /Backup
rsync --archive --delete /home/user /Backup/home
echo "Job done, bye"
umount /dev/sdb1
If the user has purchased a new external drive for this type of backup, that user will have to reformat the external drive for ext4 BEFORE executing the script. Most new external hard drives are generally formatted for FAT32 or NTFS, as they are intended to be used with W*****s systems.
Also, the mount point must be created on the main hard drive before executing the script. It is not recommend creating a separate directory, such as /Backup, on the root directory of any system's hard drive. All you need to do is delete the wrong directory by accident, and you will have to reinstall the entire operating system.
Instead, it's recommend to create "Backup" in either /mnt or /media (e.g. /mnt/Backup or /media/Backup. It is much safer to do this.
I am a KDE user and for my /home directory I ensure I have a copy of the .kde4 hidden dot file (desktop settings) and also the desktop wastebin trash.desktop, which I regularly delete. (You can always copy one over from another user and change the permissions).
Email is something you may wish to backup separately. Email clients usually have something to facilitate this, or if you know where your email is stored you can make your own arrangements.

Critical Offsite Backups.
You may well have critical and confidential files which you cannot afford to lose, and do not want them to be read by outsiders. For this the solution is to put them into a file container and encrypt them. Sent the file container to wherever you like, and when needed, recover them.
zuluCrypt is a nifty and easy to use utility. Create a container, load it with your files and send it on its way in its encrypted form.
CAUTION! BEWARE!
Before backing up anything off site, be aware of where you are storing your backed up data. Privacy and security of your backed up data should be paramount. Cloud service, such as Dropbox, are a good idea for convenience sake. However, privacy and security are not guaranteed, especially with recent events concerning Internet surveillance (NSA, GCHQ, rogue governments and groups, coups, etc.).
If you want to ,b>guarantee safety and security of your backed up data, I recommend using physical medium such as recordable DVD (DVD-R, DVD+R, DVD-RW, and DVD+RW, both single and dual layer) discs, USB flash drives, and memory cards. Recordable DVDs are relatively inexpensive compared to purchasing an external hard drive.
Also, PCLinuxOS provides K3B or Brasero for creating backups of your home directory. Simply select directories to be included on each disk. K3B tells you how much space you have used as you add files. Then burn the DVD. This takes some time and effort, but the results will be well worth the effort. You will have your data preserved on DVD discs, and you do not need to connect to the Internet to accomplish this, ensuring security of your data.

WIth USB flash drives now being available in sizes ranging from 4GB to 128GB, it is now possible to backup an entire home directory with minimal cost ($16.00 for 16GB at Big Lots) and on a device that will fit into your shirt pocket. Try that with an external hard drive.
Also, with the prices of physical storage medium so affordable, it might be a good idea to make two copies, and then store one off site (a bank safety deposit box might be a good choice). This way, if a disastrous calamity should strike your primary place of residence (fire, floods, tornadoes, hurricanes, landslides, etc.), your critical files and information are safely stored in a second location.
Summary
If you think ahead then when the inevitable happens and you have a borked system or accidentally delete a critical file, it is a non-issue. If your backup system is not in place or otherwise impaired, then you are in a bad place. As ever, with free software, it is your choice.
This article was the collaborative effort of several members of The PCLinuxOS Magazine staff. Contributing (in no particular order) were parnote, Meemaw, YouCanToo, Phil, and phorneker.
Major Updates for PCLinuxOS!
by Paul Arnote (parnote)
During the past month, two HUGE updates for PCLinuxOS were released. First, the kernel made a quantum leap from the 3.4.72 kernel, to the 3.12.16 and 3.12.17 kernels. The second major update was from Xorg Server 1.10.4 to Xorg Server 1.12.4. Both must be upgraded together in order to maintain an operable system. The new Xorg Server will not run with the older kernels. Also, the older Xorg Server will not function with the new kernels. Although it's not the newest version of the Xorg Server, it is the newest version that preserves the functionality of a rather large segment of older ATI video cards and chips.
To help insure as smooth of a transition as possible, first reload the package list in Synaptic (as you should do before performing any updates). Next, search for the new kernel (no, it isn't upgraded automatically), and select the new kernel (and all supporting dependencies) for installation. Then, click on "Mark All Updates" to mark any and all updates, including the Xorg Server updates.

The results of running infobash -v3 in a terminal on my Toshiba laptop, after the update.
Just in case you are having some difficulty reading the text in the screenshot, below is the output of infobash -v3 as text. Infobash is installable from Synaptic, and is not installed in a default installation of PCLinuxOS.
Host/Kernel/OS "localhost.localdomain" running Linux 3.12.16-pclos1 i386 [ PCLinuxOS release 2014 (PCLinuxOS) for i586 ]
CPU Info Intel Celeron 900 @ 1024 KB cache flags( sse3 nx lm ) clocked at [ 2194.529 MHz ]
Videocard Intel Mobile 4 Series Chipset Integrated Graphics Controller X.Org 1.12.4 [ 1280x800@60.0hz ]
Network cards Realtek RTL8101E/RTL8102E PCI Express Fast Ethernet controller, at port: 2000
Processes 161 | Uptime 9days | Memory 1497.2/1894.7MB | HDD ATA TOSHIBA MK2555GS,Generic- Multi-Card Size 250GB (18%used) | Client Shell | Infobash v3.05
I've updated five of my eight computers with this method, and I have only run into problems on one computer. Those five computers are configured as follows:
Lenovo G530, Intel Duo Core, 3 GB RAM, Intel 810 and later video driver.
Toshiba Satellite L305, Intel Celeron, 2 GB RAM, Intel 810 and later video driver.
Sylvania Meso netbook, Intel Atom 1.6, 2 GB RAM, Intel 810 and later video driver.
Toshiba Tecra (wife's computer), Intel Core 2 Duo, 3 GB RAM, nVidia video driver.
IBM Thinkpad T42, Intel Pentium M, 2 GB RAM, ATI X1950 and earlier video driver.
My other three computers are going to require a full re-installation, for different reasons. Since all of them -- including my recent desktop build -- run the Xfce desktop, I had been waiting for Ika's updated remaster. His new remaster includes the 3.12.17 kernel and the 1.12.4 Xorg Server. Those are now available, but I have not had a chance to perform the re-installation by the time that I wrote this article.
I then talked the magazine's assistant editor, Meemaw, through the process on her two computers, and she also completed the updates with only one small problem, which was easily solved.
On that last computer listed -- the IBM Thinkpad T42 -- I ran into some difficulties. Initially, I thought it might be that the older hardware was no longer supported by the newer Xorg Server. Thankfully, that turned out to not be the case (although I'm sure that will happen, eventually). I can't really explain why I hang onto this older computer, other than the fact that it just simply has a charm and feel about it that I like. It has served me well.
Nope. The problem turned out to be a pinned package, and a key package at that. An older version of my "ATI X1950 and earlier" video driver was pinned, and that version of the driver did not work with the new Xorg Server. I don't recall where these pinned packages came from, nor do I recall when they were pinned. In fact, I don't recall having pinned any packages at all. If you aren't familiar with pinned packages, pinning a package prevents it from being updated. Most of the time, this doesn't cause a problem. Most of the time, though, you're not pinning key system files. Rather, you typically pin the packages of a particular application. The practice is typically frowned upon, and is usually used when a new version of an application doesn't run on really old hardware that the owner/user is trying to milk every last drop of life out of. At some point, pinned packages will come back to bite you in the back side.

As a result this time, I was unable to boot into a graphical environment. Take a look in /etc/apt. If you have a file there named "preferences," chances are good that you have some pinned packages. Delete or rename the file, then reload Synaptic. Pinned files that prevented the installation of newer versions of those packages will now be installable.
Don't forget ... the first time you boot into the new kernel, it will take longer to boot. It may take up to five minutes to boot. This is because various kernel modules are having to be built. Subsequent boots into the new kernel will go much faster.
If you don't want to mess with updating your current system, you can also download the new quarterly Live CDs from April 2014, all of which contain the latest kernel and Xorg Server. In some cases, it might be easier and faster to simply reinstall PCLinuxOS. On my three computers that I need to perform a reinstallation on, I've accumulated a lot of unneeded and no-longer-used programs. Some were installed just for writing articles, and haven't been used since. On these computers, it'll be easier to reinstall the entire operating system, followed by reinstallation of those programs that I do routinely use. It would take me much more time to filter through the list of installed programs and uninstall those that I no longer want on my system.
However, if you don't have a lot of programs installed that you don't want to keep around, and you want to keep them all installed, you might want to check out my article in the September 2012 issue, called "Use Synaptic To Clone Installed Software On Another Computer." While performing that task, you might want to add in one additional step. Since Synaptic is running as the root user, root is the owner of the generated file. You might want to change ownership to your normal, regular user. One easy way to do this is to open your terminal program, traverse to the directory where you saved it, su to the root user, then use chown to change ownership of the file. On my Toshiba laptop, that command looked like this: chown parnote-toshiba:parnote-toshiba synaptic-markings-041614.txt. Simply replace "parnote-toshiba" with your user name, and be sure you're pointing to the file that you've save the information into.
Overall, the new kernel and Xorg Server does seem to make my computers run faster, and the computers seem to be more responsive. So, if you've been holding off on performing the update, I urge you to bite the bullet and go ahead and perform the updates. Unless you have some seriously old hardware that you're trying to milk the last bit of life out of, I doubt that you'll have significant problems.
Notes applying to Intel wireless networking cards
by Patrick G Horneker (phorneker)
I recently purchased a Hewlett-Packard 8510p
This laptop replaced my Toshiba L305-S5944 (after I stepped on the LCD screen in the dark by accident). I have tested the 64-Bit KDE variant. This laptop was purchased at a local pawn shop for $150!
I swapped the 120GB drive (which had Windows 7) for a 250GB hard drive (which came from my now defunct Toshiba). The machine has 3GB of RAM. This machine has a ATi Mobility Radeon HD2600 for video with an amazing 1650 x 1200 resolution.
However, the built-in wi-fi is the subject of this section. This is an Intel 4965AG that is turned off by default (apparently to save energy, and a decision made by the kernel developers), but can be switched on using the rfkill unblock 0 command (after installing rfkill from Synaptic). This is also true of the Bluetooth adapter (a Broadcom BCM2045 chipset built into the motherboard). rfkill unblock 1 enables the Bluetooth adapter.
The rfkill commands must be placed in /etc/rc.d/rc.local so that wi-fi and Bluetooth will be available at boot time.
This may hold true for other laptops that feature Intel wireless chipsets.
Game Zone: Xonotic
by daiashi

About The Game
Xonotic is a direct successor of the Nexuiz project. It represents years of development from its humble beginnings as a Quake 1 engine modification, and now aims to be the best possible open source first person shooter available. It could be considered most similar to Unreal Tournament and Quake at its heart, especially regarding teamplay and game mechanics.
Xonotic game modes, including.
Expert flag-runner? Competitive dueler? XPM, competitive settings, traditional deathmatch, team deathmatch, or clan arena! All of these and more are available in the default install.
Distinctive Weapons
Xonotic has nine core weapons and 16 full weapons. Each weapon has a UT-like secondary fire, giving you many different options for all the scenarios you'll encounter.
Player Statistics
Track your performance with the integrated statistics system, XonStat. View game-level data, such as scoreboard results, or view personal data all from the same portal. View your wins/loss ratio, frag ratio, average accuracies, and much more with ease! Best of all, no login required!
Maps
Xonotic has 18 official maps from small to large. Many more are also available from the community, including those ported from Quake! The community has several dedicated, skilled map-makers aiming to give you a unique experience.
HUD Editor
The community recognizes the need to tailor the information on your screen to what you're used to. With that end in mind, the company created a modular HUD editor for you to customize exactly what you see on your screen. Stick with the defaults, add all the whiz-bang widgets, or go minimalist – it is completely up to you!
Casual and Competitive
Xonotic is easy to learn, but hard to master! Besides thrilling action for the casual player, the game also provides e-sport opportunities for those interested in its competitive aspects. From mapping contests and monthly quick cups to sponsored tournaments, Xonotic allows every e-sport enthusiast to participate in competitions hosted by its open-minded community. Features such as simple items, fully customizable configs and servers, a functioning anti-cheat system, the spectator mode, and the opportunity to watch and record games makes Xonotic attractive to competitive players.
System requirements:
Fully updated PCLinuxOS
Hardware:These specs are not definite but are pretty close.
Minimum:
OS: PCLinuxOS
Processor: 2.2 GHz Intel Core 2 Duo
Memory: 1 GB RAM
Graphics: nvidia 6200/ATI Radeon
Hard Drive: 2 GB available space
Recommended:
OS: PCLinuxOs
Processor: QuadCore 2.0 GHz +
Memory: 2 GB RAM
Graphics: Nvidia 7600gt / ATI Radeon
Hard Drive: 2 GB available space
About The Company
The Core team consists of members who discuss and vote on large project changes. This international group of leaders is a classic group of collaborators who above all else, will try and do what's best for the game and community.
The company is basically made up of a main group of core members and many coordinators.
Some Gameplay Screenshots









Getting It To Run
You can download right through Synaptic package manager.

Also if you have problems with the Xonotic GLX launcher try the Xonotic SDL instead. Nice to see someone package this game for us. If you have ever been a slight fan of any of the Unreal games or Quake, you have got to give this a shot. I do not have the fastest PC on the block, but it knifes through this game with ease.



Encrypt Your Files With zuluCrypt
by muungwana
ZuluCrypt [1] is a project that seeks to provide an easier to use front end to cryptsetup [2] and tcplay[3]. Tcplay is a command line tool that can create and open TrueCrypt [4] formatted encrypted volumes. Cryptsetup is a command line tool that can be used to create and open LUKS formatted encrypted volumes. Cryptsetup can also open TrueCrypt volumes.
There are two kinds of encrypted volumes. There are those that use what is commonly know as "a header," and those that do not. TrueCrypt and LUKS volumes use a header. Cryptsetup has an encrypted format that does not use a header, and its commonly known as "plain dmcrypt."
There are two kinds of headers using encrypted volumes. There are those that use an encrypted header, and those that do not. TrueCrypt use an encrypted header, whereas LUKS does not. The use of non-encrypted header in LUKS makes it obvious to everybody that the volume is an encrypted LUKS volume, and this may be problematic to some people.

The use of encrypted header, as in TrueCrypt volumes, or no header at all, as in PLAIN (plain dm crypt) volumes, make these volumes indistinguishable from random noise and this may seem useful at a glance. However, its usefulness does not hold up against scrutiny, as the likelihood of being believed that a 100GB file made up of cryptographically sound random data is just a 100GB file made up of random data and not a container file for an encrypted volume is not very high. These no header volumes or volumes that use a hidden header gives what is commonly known as "plausible deniability," a still controversial topic among cryptographers.
TrueCrypt, LUKS, Apple's FileVault, and Microsoft's BitLocker, among others stores information necessary to unlock the volume within the volume itself, in the volume's header. With these volumes, the header must be provided before the volume can be opened, and a missing or corrupted header will make it impossible to open the volume. It is very important to have at least one header back up stored in a safe place, just in case the one on the volume gets corrupted some how.
LUKS stands for "Linux Unified Key Setup." It is a specification of how to store information necessary to open a LUKS formatted encryption volume. LUKS encryption format is the standard format in Linux, and a recommended one if the encrypted volume is to be used among Linux systems. TrueCrypt is a better alternative if the encrypted volume is to be shared between Linux, Windows and OSX computers.
ZuluCrypt can create and open three types of encrypted volumes, LUKS, TrueCrypt and PLAIN volumes. A PLAIN volume is a header less encrypted volume, and hence, all necessary encryption information is provided by zuluCrypt when it creates or open these volumes.
Pros and cons of the three volumes.
PLAIN:
Pro:
First, it does not use a volume header, and hence, it’s not possible to "brick" the entire volume simply by overwriting a small part of it. Second, it does not use a header, and hence, its impossible to know if the volume is made up of only cryptographically sound random data or if its an encrypted volume.
Cons:
It does not use a header, and hence, any tool that opens these volumes must provide the encryption options that were used when the volume was created. Different tools may use different encryption options, making these encrypted volumes not very portable between applications, or even between different versions of the same application.

TrueCrypt
Pro:
First, it uses an encrypted header, and hence, its not possible to know if the volume is TrueCrypt formatted encrypted volume, or if the volume is just made up of cryptographically sound random data. Second, is a hidden volume. A TrueCrypt volume can have up to two different encrypted volumes. The first volume is commonly known as "outer volume" and the second optional one is commonly known as "hidden volume". When a TrueCrypt volume is about to be opened, the user has an option to select which one of the two to open by giving appropriate key.
Cons:
It uses a header. As it is not possible to open a header using encrypted volume without its header, and hence, a corrupted TrueCrypt header makes it impossible to open the volume. If you use a TrueCrypt volume, make sure you have at least one backup of the volume header.
LUKS
Pro:
A LUKS volume can be opened with up to 8 different keys.
Cons:
First, a LUKS header is stored unencrypted, making it obvious the volume is LUKS formatted encrypted volume, and this may not be desirable under certain circumstances. It is possible to create a LUKS volume with a detached header and zuluCrypt can open these volumes using the "LUKS" plugin. Second, it uses a header. As it is not possible to open a header using encrypted volume without its header, and hene, a corrupted LUKS header makes it impossible to open the volume. If you use a LUKS volume, make sure you have at least one backup of the volume header.
ZuluCrypt can do two types of encryption. It can do single file encryption/decryption or block device encryption.
File encryption.
File encryption is done using libgcrypt as a cryptographic backend. Files are encrypted using 256 bit AES in CBC mode. The encryption key is derived from user passphrase using pbkdf2 with 10,000 rounds of iterations and sha2 as a cryptographic hash function. The resulting encrypted file will have a file size that equals (64 + 1024 * n) bytes, where n is a number starting from zero.
The file encryption functionality is for those who want to store a file or two in an encrypted form, but prefer not to go through the hassle of managing encrypted containers in image files. This functionality is akin to file encryption using gpg with a symmetric key.
How to create an encrypted file:
1. Start zuluCrypt.
2. Go to the menu and then click "zC>encrypt a file" to open a file encryption dialog window.
3. At the dialog that will show up, click the button that is on the same line as "source path" text. A file dialog will show up. Select the file you want to store encrypted, enter the password to be used to encrypt the file, and then click "create." The encrypted version of the file will be created at the path given by the "destination path" field.
To decrypt the file created with above steps:
1. Start zuluCrypt.
2. Go to the menu and then click "zC>decrypt a file" to open a file decryption dialog window.
3. At the dialog that will show up, click the button that is on the same line as "source path" text. A file dialog will show up, select the file you want to decrypt, enter the password to be used to decrypt the file and then click "create." The decrypted version of the file will be created at the path given by "destination path" field.

Block device encryption.
A hard drive or a usb stick are two examples of block devices. A regular file can simulate a block device through a use of devices known as "loop devices." These devices have a device path that starts with "/dev/loop."
The infrastructure in the Linux kernel that deals with block device encryption is called "dmcrypt," and it does its work through a process commonly known as OTF (on the file encryption). Dmcrypt devices are represented by device addresses that start with "/dev/dm," and these paths are usually accessed through their soft links that reside in "/dev/mapper."
Below is an example of steps taken in creating a 100MB encrypted container in a file, and adding a file in it to be stored securely.
1. Create a 100MB file.
2. Attach a loop device to the file.
3. Create an OTF encryption mapper against the loop device.
4. Put a file system on the encryption mapper.
5. Mount the file system on the mapper.
6. Copy the file to be stored securely to the file system through the mount point.
7. Unmount the file system.
8. Destroy the OTF encryption mapper.
9. Detach the loop device from the file.
10. Maintain the encrypted volume as a secure holder of files within it.
All zuluCrypt does is provide a GUI to make it easy to do above specified tasks.
With the above steps:
Step one deals with a path that look like "/home/ink/secret.img." This is a path to a regular file.
Step two converts the "/home/ink/secret.img" file to something like "/dev/loop0" loop device path.
Step three converts "/dev/loop0" loop device path to something like "/dev/mapper/secrets.img". Data written to "/dev/mapper/secrets.img" will get encrypted, and then passed forward to "/dev/loop0" on their way to "/home/ink/secret.img". When data is read from "/dev/mapper/secrets.img," the data will be read from "/dev/loop0," who in turn, will read it from "/home/ink/secret.img," decrypted by dmcrypt, and then given to the reader. This process is called "on the fly encryption" because the encryption mapper does not store or hold on to data. Rather, it gets data and then encrypts or decrypts it, depending on the direction of data flow, and then passes it along.
How to create an encrypted container in an image file.
1. Start zuluCrypt.
2. Go to "menu>create>encrypted container in a file" to open a dialog window.
3. Enter the name of the file to be used to hold the container in the "file name" field.
4. Enter the size of the container in the "file size" field.
5. Click "create."
6. Wait for the container file to be created, and for the volume creation dialog to show up.
7. Enter the password to be used to create the volume.
8. Select the type of volume you want to create from the "volume type" list.
9. Click create to create the volume.
How to create an encrypted container in a partition.
1. Start zuluCrypt.
2. Go to "menu>create>encrypted container in a partition" to open a dialog window.
3. Click/double click on the partition you want to create a volume in, and then advance to step seven in the instruction list above. If the partition you want to put an encrypted container does not show up on the list, then restart zuluCrypt from root's account and try again.
How to open an encrypted container that reside in a file using zuluCrypt.
1. Start zuluCrypt.
2. Go to "menu>open>encrypted container in a file" to bring up a dialog window.
3. On the dialog window, click the button to the right of "volume path" field, and then browse to where the volume is and click it to open it. Alternatively, you can just drag the volume file on zuluCrypt to generate a password dialog prompt with the file path already filled in.
4. Enter the volume key in the volume key field, and then click "open" to open the volume.
How to open an encrypted container that reside in a partition using zuluCrypt.
1. Start zuluCrypt.
2. Go to "menu>open>encrypted container in a partition" to bring up a dialog window.
3. On the dialog window, click/double click on the partition with an encrypted volume you want to open.
4. Enter the volume key in the volume key field and then click "open" to open the volume.
With both of the previous methods mentioned above, the volume will be opened and mounted at a path whose last component is given by the entry in the field "mount name." When the volume is successfully opened, zuluCrypt will automatically open the mount point path. To close the volume, click its entry on the zuluCrypt window, and then click "close" on the pop up window.
ZuluCrypt can open an encrypted volume using keys derived from different sources. These sources include a pass phrase, a key file, a key retrieved from kwallet, a key retrieved from Gnome's libsecret, a key retrieved from an internal secure storage system, and a key from a GPG encrypted key file, among other sources.
To use a passphrase volume key, make sure the key source option reads "key," and then enter the passphrase on the entry field at the bottom.
To use a keyfile as the source of volume key, click the option bar, select "keyfile," and then press the button on the lower right to bring a dialog box that will allow you to browse to where the key file is.
To use a plugin as the source of the volume key, click the option bar, select "plugin," and then press the button on the lower right to bring up a list of available plugins. Select the one you want from the list.
Volume keys stored in Kwallet, Gnome keyring or internal secure storage system plugins can be managed by going to "menu>options>manage volumes in internal/kde/gnome wallet."
Storage of keys in a Gnome wallet/keyring seem most appropriate in a gnome session. but this has some security repercussions. The keys are stored in the user keyring, and this keyring gets unlocked when the user logs in. This means that once a user is logged in and the keyring is open, any application that runs in that user session can read those keys using public APIs exposed by the storage system.
In a KDE system, a Kwallet secure storage system seems most appropriate, but it suffers from the same security problem that the Gnome secure storage system has. Once the wallet is open, any application running in the user session can access it using public APIs exposed by the storage system.
The behaviors of the above secure storage systems is by design, but this design may not be ideal for some users under certain use cases. The internal secure storage system is powered by libgcrypt, and it does not have the behavior of the above two systems. An unlocked internal secured storage system is accessible only to the instance of zuluCrypt that unlocked it.

Favorites.
For convenience, most used volumes can be easily opened by adding them to the favorite list.
Entries on the list are added in the dialog window opened by clicking "menu>options>manage favorites". Favorite entries are added by clicking the "favorite" entry on the menu.
Erase data in a device.
It is very important to create encrypted volume over cryptographically strong random data to make it impossible to know what part of the encrypted volume has been used and what part has not. If the encrypted volume is created over predictable data patterns, like on a device with only zeros in it, forensic analysis may reveal how much and what part of the encrypted volume are in use.
When creating an encrypted container in a device, zuluCrypt offers an option to first write random data over the device. This feature can be performed on other devices by activating it through "menu>erase data in a device". Random data is written to disk by opening a plain dmcrypt encryption mapper on the device with a 64 byte random key, and then blasting zeros on the device through the mapper. This technique has proven to be faster when compared to alternatives, like writing random data on the device read from "/dev/urandom."
System and non system volumes.
To enforce access controls on what user can access what block device and what they can do with the access they have, zuluCrypt employs a concept of "system volumes" and "non system volumes."
A system volume is defined as a volume that has an active entry in "/etc/fstab", "/etc/crypptab", "/etc/zuluCrypt/system_volumes.list," or if udev identifies it as such, if udev is enabled. Ideally, all volumes inside the computer are to be considered system volumes.
A non system volume is a volume that failed in the above considerations, or if it has an entry in "/etc/zuluCrypt/non_system_volumes.list". Ideally, these volumes are pluggable USB based hard drives or USB sticks.
Partitions can be added or removed from the list of system or non system volumes simply by starting zuluCrypt from root's account, then going to "menu>options>manage system volumes/manage non system volumes," and then adding the volume in the appropriate list.
Permissions.
ZuluCrypt limits what a user can do on block devices through Unix's group based permission system using two groups, "zulucrypt" and "zulumount."
If a device is identified as a system device, only a root user or a user who is a member of group "zulucrypt" can create an encrypted volume in the device or taking/restoring volume headers. If you want to create a volume in a device and the device does not show up on the list, restart zuluCrypt from root's account and try again.
If a device is identified as a system device, zuluMount will mount it only if the user is root, is a member of group "zulumount," or the device has an entry in "/etc/fstab" with either "user" or "users" mount options set.
ZuluMount.
ZuluMount is a general purpose mounting tool that can open zuluCrypt supported encrypted volumes, as well as non encrypted volumes.
ZuluMount can also auto detect plugged in devices and auto mount them.
Footnote references:
[1] http://code.google.com/p/zulucrypt/
[2] http://code.google.com/p/cryptsetup/
[3] https://github.com/bwalex/tcplay
[4] http://www.truecrypt.org/




Make A Greeting Card Under Linux
By Meemaw
A post was recently made in the PCLinuxOS Magazine section of the forum asking about a program to make greeting cards. A greeting card website was shared where you can choose from their pre-made cards and print them out. However, sometimes I want something I can't find on their site, or the available cards are not to my liking. ScribusStuff.org has a few templates to help, and I downloaded a couple of templates to open in Scribus. You can also make your own in LibreOffice Draw or Scribus. Let's make a quarter-fold greeting card in each.
LibreOffice Draw
The first thing I did in LibreOffice Draw was to open a single page in portrait orientation. I then set my margins at 0.25" (Format > Page...). Since this page will be folded in half twice, I created a couple of guide lines down and across the center of the page each way. I made them a light gray so they are barely visible, but visible enough for me to see them as fold lines for the finished product. They can be left in or removed before the card is printed.

Let's add the front of the card. You can add any graphic on the bottom right of the page. I'm sure I don't have to caution you about only using artwork that you have the right to use (your own stuff, Creative Commons, etc.). The picture I will insert is one I took at Butchart Gardens in Victoria (Canada). Make sure you save your LO Draw file with an appropriate name. I think mine is Birthday1.odg.
Next comes the text frame. If it is the inside of your card, it needs to be placed in the upper left corner of your page. Reminder: In order for the card to display correctly in portrait orientation after it's folded, the graphics & text on the top half of the page need to be upside down. Create your text frame and enter the text you wish. Under the Modify menu, choose “Rotate." The corners of your frame will turn red and, when you hover your mouse over one, will change to a rounded arrow. Grab a corner and rotate it until it is as you want.


Put in any other text or graphics that you want, and save your file. After you print and fold, it will look similar to the card below;

You can also save this as a template by clicking File > Save As Template.... The Templates Manager will open and you should click Save. A small window will open asking you to name your template.
Scribus
The process for this same card starts out similar in Scribus. Set up your page and margins the same, but now add image and text frames in the appropriate spots, bottom right for the card front, top left for the inside right, and so on. Remember, the inside right text needs to be upside down on the page to look right when it's folded. Therefore, your text frame needs to be rotated 180 degrees in the settings. See the example with text below.

At this point, you can save your document with just frames as a template.

In Scribus, you right-click the image frame and choose Get Image... to add your graphic. You should adjust the image frame to suit your graphic and the text frame for your captions. You can add more graphics and text as you desire.

Any time you need a greeting card, you can open your template, add your graphics and caption, and your card can be printed, folded and mailed.
In case you need to refresh your knowledge of Scribus, the magazine's Scribus guide can be found here.
Now we have three methods for making greeting cards in Linux. I hope you find one that works well for you. I have included the templates I saved here.
PCLinuxOS Family Member Spotlight: 7272andy
by 7272andy as told to Smileeb

How old are you?
I'm 51, though I tend not to act my age (according to my wife).
Married, single or what?
I've been happily married to Mary for the past 19 years.
Children, grandchildren?
Unfortunately, we were never blessed that way
Retired or working and for how long and at what.
I've been working for the same employer for the last 35 years variously as an Engineer (land and marine), Meteorologist, Software Developer, Software Integration Tester and Project Manager.
What is the area you live in like. Weather, Quietness, Scenery.
We live approximately fifteen miles from the Georgian city of Bath on the edge of a village by open fields and woodland. The area tends to be quiet and affords some good walks.
Are you handy with your hands and have any hobbies.
I'm not a total loss when it comes to practical stuff, but I do tend to be short of time. I only have 1/2 of the weekends available as the rest is taken by Sunday School and my in-laws. Hobby-wise, I do a lot less these days, but previously I was County Fencing Coach (until forced to stop due to a combination of basal thumb arthritis and pneumonia), a preliminary swimming teacher and a Royal Life Saving Society Trainer/Assessor. Nowadays I content myself with the Gym, Allotment Gardening and trying to lose weight.
What is your education level?
I graduated from Brunel University in Uxbridge with a Masters Degree in Engineering.
Do you like to travel, go camping?
We both like to travel, though we haven't camped for around 7 years now. We don't get around quite as much as we used to, though we still manage to get away; walking, occasionally playing with power kites and bodyboarding in North Devon, skiing (usually in Norway or Finland) and wandering around in Italy.
What caused you to try Linux and join this forum?
Back in 2006, I was testing Windows Vista and realised that no matter what the testing threw up, it would be released and hopefully patched later, irrespective of the problems (and there were some big ones), as missing the release date was not an option. Windows XP was (still is, and will be for a while), my employer’s platform of choice. I was just getting tired of spending money to stand still.
At the same time, I needed to set up up a small network of internet capable machines that were protected against virus and malware attack, and took the opportunity to play with Linux. I initially used Suse for that project, though I finally settled on Yoper.
I distro-hopped for a while (taking in both junior and big daddy) but didn't settle until the advent of the PCLinuxOS 2007 release. I initially joined the forum to rectify a driver issue, which Tex solved within 2 hrs of my posting (thanks boss), and I've been here ever since. I'm not as active within the community as I'd like to be, but as I've said, time is currently very limited.

Llfracombe Harbour

Near home in the snow

The two of us in Lucca.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by smileeb, featuring PCLinuxOS forum members. This column will allow “the rest of us” to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to smileeb in the PCLinuxOS forum expressing your interest.



Quick Tip: Dolphin Previews
by loudog
This quick tip was inspired by the continuing issues I have had with previews not always working after updating. Although this seems to be a rather isolated experience, it has nagged me on a few occasions. If you open Dolphin and select Preview, you should be presented with a much more detailed thumbnail in the file window. Does your window look like this?

It's a simple matter of selecting which previews you would like Dolphin to display for a more visual experience. At the top of Dolphin's window is the settings option. From the dropdown menu select Configure Dolphin.

From this window select the General option, then select the Previews tab.

From this window, you can check any number of file types to get a nice preview of them in the file manager. This is what the window looks like after I have made a few selections.

Just remember to click the Preview option in the main Dolphin window to show them.

If at this time you do not see all the previews properly you may need to also go to the kde folder configuration window. first click on the cashew at the top right of your desktop.

Select the folder settings, icons, then select the "More preview options."

The menu you will be presented with is similar to Dolphins preview selection window.

Check the preview options you desire and there you have it, many nice icon previews for your enjoyment and quick reference.
Now you can have your cake and eat it, too. I enjoy the larger previews as my eyes get older, especially when working with the thousands of video files I have. It makes my favorite Distro easier to work with for extended periods without wearing out my eyes. I wonder how long before we see our beloved penguin wearing spectacles? I guess time will tell. Have a long enjoyable romance with PCLinuxOS. It will continue to be there for you.

Handy Utilities to Organize Your life, Part Two
by Meemaw
Calendars and Event Reminders
Now that we have all sorts of notes to organize things, we need to add something to remind us when to do everything. While I generally know I want to go to the grocery store today, I sometimes need something to remind me about the meeting on the fourth of next month. So, now we need some sort of calendar program. Synaptic has at least six that we can review.
Day Planner
Day Planner is one of the smaller programs. It is very simple, but not too configurable, in my opinion. Opening the program, the window that appears is below. An icon is also added in your system tray. You can also get reminders when you boot your computer, unless you close the program down completely.

Using the Add button in the lower left, you can add an event or reminder to your calendar, which is shown in the upper right side of the window. You will get a small window, which opens to a larger one by clicking on Show advanced settings. You choose the event type from the drop-down (choices are Normal, All Day and Birthday). If you choose Birthday, your window shrinks to two lines, Born and Name, and your day list will show the name on their birthday with their age included. Normal and All Day give you a few more things to add, including time, description, any recurrence and a detailed description of the event. If you make a mistake, simply choose your event and click on the Edit button (lower left). If your event is canceled or you don't need to be reminded any longer, click the Delete button.

When you get your events, reminders and birthdays entered, the space below the calendar with show a list of everything you have in the next seven days starting today. Birthdays and all day events will be listed with no times, but normal events will show a time. The default is 9 am so be sure to change it to the correct time. A reminder window pops up when you boot your computer.
The reason I say it is not too configurable is because there is no way to change the date format, and the time format looks funny to me with only one zero in the minutes spot. The left side of the window can be resized by resizing the whole window, but the calendar and event list is a set width. Also, you can enter a detailed description of your event, but it doesn't show anywhere in the main window. However, if you want a really simple calendar, you might like Day Planner.
Orage Calendar Extras
I use Xfce, and Orage is one of the programs that displays the clock. However, you can left-click the clock once and the following calendar will appear, along with a calendar icon in your system tray.

Double-clicking any particular date will open the following window. From here you can add an event, or a todo list or add to your journal. You can also open this window by clicking the desired date and selecting View > View Selected Date.

I have already added one event to the list above, as you can see, but more can be added. For each addition, choose the section you want to add to, then click the New Entry button at top left, which looks like a single sheet of paper. The following window will open so you can configure the event you are adding. If you decide you chose the wrong type, there's a place to mark the correct one in this window.

Fill in your sections and save. Events will show up at the bottom of the main calendar. Like Day Planner, you will need to open your reminder to view any details in the notes. Alarms will appear at the reminder time you specify.
gremind
gremind features a small calendar with a reminder option at the bottom. It also adds an icon to your system tray when it's running.

Simply click on the date you want to add to, then fill in the message and time. Also, choose whether it is once, daily, weekly or monthly. Then, click the plus sign to add. The tools across the bottom are as follows: Add, Undo, View Reminders, Settings, Close Window and Close Program.
You can view all your reminders by clicking the tool (magnifying glass) at bottom. The list shown below is the window that appears. The image also indicates the tray icon.

This one is even smaller than the previous two, having no place to put any extra notes..
tkremind
tkremind is the GUI frontend for the CLI program remind. You can install only the CLI program if you want, but I'm better with the GUI. When you start the program, a large calendar appears. The present date will be highlighted. You will see some tools at the bottom of the window. They include backward one month and forward one month buttons, a button for today, and a button to take you to whatever date you want. You will also see a Print option and the settings button, labeled Options. Completing the tools, you have a Quit button, a section telling you the current date and time and a readout of the reminders that exist in the program.

A single click on your desired date will open the window below. Many of your options can simply be checked. Each of the boxes can be changed to reflect the reminder time, date, duration, etc. of your event. You still won't have any extended note, but it's a bit more configurable.

GKrellM reminder plugin
Many of us use conky or some other monitoring program. GKrellM is a good program as well, having several plugins that will extend its functionality. One of those is the Reminder plugin.

If you use GKrellM, you know that the way to pull up the configuration menu is to right-click the heading in gKrellm and choose Configure. Each krell has its own section so you can enable the things you want to see and configure each. The reminder is in the Plugins section, and must be enabled before you can configure it.

The reminder section of GKrellM will show the little notepad on a line with a fraction (it's 0/0 in the image above, but will change to reflect events that are close). This one works a little differently. You add your event using the window above, but the start date should be the date you want to start getting reminders. The end date should be the date of the actual event. Your reminders will start popping up on your start date.
It's not real configurable, but works pretty well.
KOrganizer
This one is another that has more than just a calendar with reminders. You will see icons to add events as well as To-do's and Journal entries. One nice thing about this program is the variety of layouts you can use. Some people like to look at only one day's events, but a week or a month can be viewed. In the image below, I am viewing a week. When I took the screenshot, it was 10:22 am on Tuesday, March 11, 2014, as you can see by the indicated time in the window. In the image farther below, I am viewing a month.

Before you can add anything, you need to designate a calendar file to use. The configuration window usually pops up when you open KOrganizer the first time. You can also add another calendar by choosing Settings > Configure KOrganizer and clicking on the Calendars tab. Click the Add button and choose from the list of calendars.

When you have designated a calendar file, then you can begin adding events. To add anything, simply click on the New Event, New To-do or New Journal button. The top drop-down is the calendar file where you want your event added.

You can add the event name, configure the times, and set up recurrence and alarms, then press Apply. Your event will then show up on your calendar.

When you boot your computer on the day a reminder is due, you will see a window like the one below. You can choose to dismiss the reminder, or snooze it so it will pop up again. The Trigger Time is the time that the reminder popped up (my KOrganizer is in Virtual Box).

If you use KDE, KOrganizer is a good reminder system.
I also found a birthday reminder plugin in Pidgin, but I think it's too limited to really be of much use. It will remind you of a friend's birthday, but only if they are in your Pidgin buddy list, and only if they have entered their birthday into their IM account.
We have seen several reminders, and I hope you find one that works well for you. As always, you may love one of these and hate another. Since this is Linux, it's your choice which one(s) you install and use.
Programming With Gtkdialog, Part Two
by Pete Kelly (critter)
In the last article, I demonstrated how to write some gtkdialog code that would produce a simple utility that actually worked, without having to know, in any detail, how the code worked.
This time I am going to expand on that, and fill in some of the detail that will enable you to write simple code that does what you want, in the way that you want it to do it.
I shall explain how to use some more of the widgets available in the gtkdialog repertoire, how to change their appearance, add functionality and to communicate with them. As we progress, it is inevitable that the requirement to have some scripting knowledge and experience would be beneficial, but not essential. If you follow through the articles, then you will acquire most of these skills along the way.
The examples shown all use a minimal shell 'wrapper' to keep things a simple as possible.
We have seen how to produce a dialog with both pre-defined gtkdialog buttons and user configured buttons, which were placed inside frames, hboxes and vboxes.
The theory
First some theory, although if you find this boring and difficult to understand then please feel free to jump ahead to the examples. You can always come back if there is something that you don't understand.
The gtkdialog button has to be placed into a container. This is mandatory. The container is often placed inside a window widget.
Containers are usually vboxes, hboxes or frames, and these may be freely mixed, much as putting plastic bags inside plastic bags into a freezer compartment. Each plastic bag must contain either other plastic bags, widgets or a mixture of both. Between the compartments, we may have dividers, which may be dedicated horizontal and vertical divider widgets, or even empty hboxes and vboxes, which can also enable you to space items as required.
Widgets may not be placed alone inside a dialog window. Widgets have:
Attributes that describe their appearance within the container.
Directives that describe how they should be presented and respond to user interaction.
Signals which allow them to interact with other elements of the application.
They are also subject to the application of functions upon them, subject to certain conditions being met.
The widgets
The window widget
This is not necessarily required, but it does allow you to control the position and size of the application, and to specify a window title and the icon that will appear on the window title bar and the taskbar. You can see how to do this at the beginning of the launcher application, code demonstrated in the previous article.
Containers
In our 2x2 button example, we had one vbox. All items in a vbox are arranged in a vertical stack. Ours contained 3 hboxes and 2 hseparators, which were stacked vertically in the order presented in the code. The vbox was sized automatically to accommodate all of its 'children' using the default sizes maintained by gtkdialog. The window was sized to accommodate the vbox.
The items in the hboxes were arranged in a single horizontal row, again in the order presented in the code. These hboxes were sized to accommodate the number of widgets in the largest row. The hboxes with fewer widgets right-align their widgets which is why, in the bottom hbox, the cancel button appears on the right. This limitation can be overcome by adding the homogeneous=”true” tag to the container which will distribute all of the widgets equally.
The following example does nothing but demonstrate the use of this tag. The window widget has been forced to a size that stretches the hbox to show the effect.
#!/bin/sh
export MYDIALOG='
<window width-request="400">
<hbox homogeneous="true">
<button help>
<action>EXIT:Help
</button>
<button cancel>
<action>EXIT:Cancel
</button>
<button ok>
<action>EXIT:Ok
</button>
</hbox>
</window>
'
gtkdialog --program=MYDIALOG

Frames are also containers, but do not normally affect sizing (other than to add their own size). Frames are decorative and allow sub-grouping of widgets.
All of this default sizing may be overridden.
Buttons
A button may contain a label, an image or both, and the position of the image is controlled by the image-position attribute (0 left, 1 right, 2 top, 3 bottom). The image size is controlled by the 'height' and 'width' attributes. When a button has the 'sensitive' attribute turned off, it is greyed out and does not respond to clicks. This property can be enabled or disabled by other widgets. A button can be given a name to enable it to be referenced by other widgets. This is performed with the directive 'label.' The example shows two buttons named 'wp' and 'ss.'
Example: The writer button has sensitivity turned off on start up. Clicking the buttons toggles the state of the other button. Image position 2 puts the image centrally above the label. The word processor icon has been re-sized, but the spreadsheet icon retains the gtkdialog default dimensions.
#! /bin/bash
export MAIN_DIALOG='
<vbox>
<button image-position="2">
<input file>writer.png
<height>100
<width>70
<label>Write
<variable>"wp"
<sensitive>"false"
<action type="enable">ss
<action type="disable">wp
</button>
<button image-position="2">
<input file>calc.png
<label>calc
<variable>"ss"
<sensitive>"true"
<action type="enable">wp
<action type="disable">ss
</button>
</vbox>'
gtkdialog --program MAIN_DIALOG

Note that for these examples to work you must give the full path to
the graphic files or copy them to the same directory as the script.
In addition to the pre-defined buttons that I have already mentioned, gtkdialog provides access to a host of 'stock items.' These are icon-label pairs that may be used in buttons, menu entries and several other widgets. To get a look at what is available, try executing this script.
/usr/share/doc/gtkdialog/examples/tree/tree_icon_stock_ids
Just copy and paste the above line into a terminal and press enter. You should see something like this.

In a button, you may use both label and icon or just the icon, but the methods are different. An example will illustrate this.
#! /bin/bash
export MAIN_DIALOG='
<vbox>
<frame Icon and label>
<button use_stock="true" label="gtk-page-setup">
</button>
</frame>
<frame Icon only>
<button>
<input file stock="gtk-page-setup">
</button>
</frame>
</vbox>
'
gtkdialog –program=MAIN_DIALOG

Clicking a button triggers a 'signal.' The default signal for a button is 'clicked,' and this can be used to perform a function on another widget. In the next example, the 'write' button is hidden or shown, depending on its current state. The hide and show buttons do what their titles suggest to the write button. As the write button has no declared 'action,' clicking on it executes the default action, which is to terminate the script.

#! /bin/bash
export MAIN_DIALOG='
<hbox>
<button image-position="2">
<input file>writer.png
<label>Write
<variable>"wp"
</button>
<button>
<label>hide
<action signal="clicked"
condition="visible_is_true(wp)">hide:wp
</button>
<button>
<label>show
<action signal="clicked"
condition="visible_is_false(wp)">show:wp
</button>
</hbox>'
gtkdialog --program MAIN_DIALOG
Signals become more useful when used in dialogs with many different types of widgets. As an example, checking a checkbox widget might enable and give focus to a text input widget, or refresh the contents of a statusbar widget.
There are many ways that you can modify the appearance and functionality of widgets, far too many to mention here, so I will just cover enough to make the widgets accessible for use in your scripts. Those that I have covered in the button examples will give you some idea of the flexibility of gtkdialog. For more detailed information, please refer to the links I provided earlier (in the previous article).
Text
You can put text into a dialog with the <text></text> tags. The text that appears in the dialog can be defined in these ways.
<label>This is my text</label> Any static text.
<input>command</input> The output from a command such as ls.
<input file>filename</input> The name of a text file to display.
If displaying the contents of a file and you include the tag_attribute <text auto-refresh=true>, then if the contents of the file are changed by some other process then the dialog contents will automatically be updated. The text can also be refreshed by using a button to execute the refresh function.
This example overrides the default automatic sizing by submitting a width request of 300 pixels. It then displays the last ten lines of kernel messages through the command dmesg | tail. This text can then be updated by clicking the refresh button.
#!/bin/bash
export MY_DIALOG='
<vbox width-request="300">
<text>
<variable>MSG
<input>dmesg | tail
</text>
<hbox>
<button>
<label>Refresh
<action>refresh:MSG
</button>
<button>
<label>Done
</button>
</hbox>
</vbox>'
gtkdialog --program=MY_DIALOG

For the adventurous, there is the option to add text attributes, such as bold and color, through html type mark-up tags, and to provide updates through timers.
The checkbox, radiobutton and togglebutton.
Check boxes are used to get the user to choose or reject an option. Radio boxes are similar, but should be grouped, and only one member of the group can be selected at any time. The togglebutton is a strange animal used for switching between two states which is essentially what a single checkbox does. Perhaps I'm missing something, but I'll skip this widget, as I've never found a use for it.
First the checkbox.
Here we have two actions for each box. The first is executed only if the box is checked (true) and the second one, you guessed it, if the box is unchecked (false).
Although this script only highlights icons, a usable script would include some code that actually manipulated the connection.
We haven't seen the pixmap widget before. This simply displays a graphic, but the graphic has attributes than can be manipulated by other widgets.
You should take care when assigning variable names and labels that you don't duplicate things, but that they are still descriptive. I have used a mixture of upper/lower case characters and spelling to make each unique.
You should also remember to set the default state of each checkbox.
The use of various containers in this example controls the layout of the application.


Now the radiobutton.
All of the buttons are contained in a vbox, which relates them, and only one may be active. Selecting one of the group automatically deactivates the rest of the group. The vbox has the homogeneous attribute set to true to equally distribute the buttons within the same vertical space as the larger pixmaps.



By using these few widgets, you can build some quite impressive utility applications with minimal programming experience. With a little bit of command line knowledge, you can assemble tools to match some of those that have already appeared in the PCLinuxOS repositories. That will help other users of the distribution, and will almost certainly put a self-satisfied smile on your face.
Is there more to this gtkdialog? Oh yes! A whole lot more, which I shall start to demonstrate in future articles.
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